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CHAPTER 15

Charts

Okay, it’s time to have some fun. Microsoft Excel charts are among my favorite fea-
tures in any program, and that hasn’t changed with the introduction of a brand 

new charting engine for Microsoft Offi ce Excel 2007.

To me, fun with software is when content looks so great or works so well in a document 
that you assume it must be diffi cult to create, but it’s actually easy. That’s charting in 
Microsoft Excel, and that’s what we’re going to look at in this chapter.

Creating and formatting high-quality, complex charts can be positively, absolutely easy. 
And, despite the loss of a few familiar shortcuts with the introduction of the new Offi ce 
Excel 2007 charts, the gains outweigh the losses on the changes to this major piece of 
Excel functionality. There’s a lot to be said for giving charts the formatting fl exibility 
they now have. There are also enough new timesavers that you aren’t likely to miss 
those few retired favorites for very long.

Chapter Assumptions
I’m not going to take your time in this chapter to show the difference between a plot 
area and a chart area, or explain what a data label is. I won’t step you through the pro-
cess of creating a chart or tell you when to use a column chart or a line chart. 

Instead, skipping quickly through some basics you already know with quick tips and 
best practices, this chapter focuses on making effective use of the new charting tools. 
Everything in this chapter is based on the assumption that you knew charting basics 
before you got here and have confi dently created at least basic charts in a recent version 
of Excel.

Similar to the preceding chapter on working with data in Excel, this chapter takes an 
advanced layperson’s approach. Though I go into detail on the idiosyncrasies of various 
chart elements and provide troubleshooting directions for a number of issues, I don’t 
cover scientifi c or technical charting, such as engineers might require.

So, if you’re a scientist, engineer, or in another math-centric profession that requires 
technical charting, you are still likely to fi nd new information in this chapter. However, 
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you might also want to explore some more technical charting resources, and so I’ve 
provided links to some of those on this book’s CD.

Note, however, that this chapter does address two specifi c advanced chart types that 
are worth exploring regardless of the chart types you usually need. Price/volume 
charts and bubble charts have a number of formatting peculiarities, the details of 
which can help you better understand and manage custom requirements for a wide 
range of complex chart types. So, I highly recommend sticking around for those parts 
of the chapter even if your only possible need for a price/volume or bubble chart would 
be if you decide to dress up as an investment banker for Halloween and fi nd yourself in 
need of props.

In the introduction to this book, you can fi nd a list of resources for those who want more 
basic-level information, in the section titled “Who Will Benefi t Most from This Book.”

What’s New for Charts in Excel 2007
This section is quite different from the “what’s new” section in many chapters because 
the answer in this case is both everything and nothing. The charting engine is entirely 
new, which means that charts look different, have different formatting capabilities, and 
offer different methods for editing and managing chart elements.

However, whatever chart types you knew how to create before, you still know. Most of 
the customizations you’ve made to charts in the past you can still make. We’ll be look-
ing at new features, new capabilities and limitations, and new methods throughout this 
chapter. But, it’s important to know that most of what you already know about Excel 
charting is still valid.

As mentioned earlier, a few shortcuts are gone, but in place of some are new and even 
easier options. For example, you can no longer double-click a chart element to open 
its format dialog box, but you can still right-click or press Ctrl+1. And, most chart ele-
ments are now exposed on the Chart Tools Layout tab for much quicker access than in 
the past. 

The shortcut I miss the most is the ability to drag a data point along the value axis in 
order to change data directly on the chart. But, I’m willing to forgive that loss for my 
favorite new timesaver—you might not believe how easy it is to size Excel charts for use 
in other programs.

The preceding examples notwithstanding, attempting to outline every new element of 
an entirely refurbished major feature in one little upfront section just won’t do it justice. 
Instead, please consider this entire chapter the answer to “what’s new for Excel charts.”

Note
For information on the new Chart templates, see Chapter 20, “The Many Faces of Micro-

soft Offi ce Templates.”

Note
For information on the new Chart templates, see Chapter 20, “The Many Faces of Micro-

soft Offi ce Templates.”
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The New Essentials for Creating Charts
Before diving into more advanced topics, following is a quick summary of some chart-
ing essentials that have changed as well as confi rmation of a few things that remain the 
same.

 To create a chart on its own sheet, you can still use the shortcut F11—which cre-
ates the default chart type. This is now the only method for creating a chart di-
rectly on its own sheet. You can, however, move any chart to its own sheet after 
creating it, as discussed later in this list.

 Initially, the default chart type is a clustered column chart. However, to set a dif-
ferent chart type as your default, on the Insert tab, in the Charts group, click the 
dialog launcher to open the Insert Chart dialog box. Then, just select the chart 
type that you want to use as your default and click Set As Default Chart. Nothing 
will appear to happen, but your default chart type will change. To confi rm this, 
close and reopen the Insert Chart dialog box. The chart you set as your default 
should be selected.

 If the data range for your chart is contiguous, you can simply click in the data 
range and then create your chart. The entire range does not need to be selected.

 If your source data is in a table, the chart sees the table as the data range. What 
this means is that if the table cell range is increased or reduced, the chart will 
automatically update to refl ect the revised data range. See Chapter 14, “Working 
with Data,” to learn about structured references to tables. 

Note
If you delete a row or column from an Excel table being used as a chart’s source data, 

you may get an error message when you next access the chart. However, after you click 

OK to dismiss the error message, the chart should update correctly to recognize the 

change in the data range.

 If you create a chart from the Chart group on the Insert tab, including using the 
Insert Chart dialog box, it will be created as an object on the active data sheet. 
The new charting engine doesn’t offer a Chart Wizard. Just select your data (re-
member that to use noncontiguous data, you need to hold the CTRL key while 
selecting) and then either press F11 for a chart on its own sheet, or use the Chart 
group on the Insert tab to create a chart object on the active sheet.

Note
If you delete a row or column from an Excel table being used as a chart’s source data,

you may get an error message when you next access the chart. However, after you click 

OK to dismiss the error message, the chart should update correctly to recognize the

change in the data range.
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CAUTION!
When using the CTRL key to select noncontiguous data, it’s important to drag to select 

any contiguous areas within the data, just as you would for a single contiguous data 

source. Individually selecting cells that you intend to be part of the same series can cause 

undesired results.

 To change the type of chart after it’s created, select the chart and then, on the 
Chart Tools Design tab, click Change Chart Type. Or, right-click the chart and 
then choose Change Chart Type.

 To move a chart between its own sheet and a worksheet, on the Chart Tools De-
sign tab, click Move Chart, or right-click the chart and then click Move Chart.

 Not all chart types, of course, are appropriate for all data—and different chart 
types may be more or less effective depending on both the data and what you 
want the data to express. In the Insert Chart dialog box (or the Change Chart 
Type dialog box—which contains the same options), you no longer see descrip-
tions of chart types, as you do in earlier versions. However, they’re not gone. 
When you point to any chart type in the Chart group galleries on the Insert tab, 
a ScreenTip gives you a description of what the chart type displays and, in many 
cases, when to use it. For example, see the ScreenTip for a Clustered Bar Chart in 
the image that follows.

If you’re not positive about the most effective chart type for your data, use the 
Change Chart Type option on the Chart Tools Design tab to try out a few before 
you spend time customizing formatting. Also keep in mind that simple custom-
izations, such as changing the axis scale to more snugly fi t your data range, can 
have a substantial effect on the statement you make. 

For example, the following charts use the same data. The only difference between 
them is that the minimum and maximum values on the vertical (value) axis for 
the chart on the right have been customized to fi t the data.

C U O !
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Finally, if you’re not sure of your data’s best side, consider using a PivotTable to 
fi nd it. PivotTables are easier than the great majority of Excel users think they are, 
and they’re designed to be Excel’s very own spin doctors. See Chapter 16, “Power-
ful Reporting, Easier Than You Think,” to learn how to create and use PivotTables.

Fighter-Pilot Cool Chart Formatting
This is where you garner the benefi ts of change. The new charting engine is part of the 
overall new graphics engine for the 2007 release. So, charts now have formatting capa-
bilities very similar to drawing objects, such as SmartArt diagrams or shapes.

In addition to fancy formatting, this section looks at customization options from indi-
vidual chart elements to the overall chart layout, as well as considerations for unique 
chart types.

Using Chart Quick Styles
Just because you want charts to look customized doesn’t mean you have to do it all 
yourself. Charts offer two types of Quick Styles that are designed to work together—
Chart Styles and Chart Layouts, both of which are available on the Chart Tools Design 
tab, as shown here.

Like any set of Quick Styles, each choice within these two sets applies several format-
ting attributes at once. So, you can apply a Chart Layout that’s close to what you want, 
for example, and then further customize individual chart elements as needed, such as 
deleting gridlines or adding data labels. Or, select a Chart Style that includes a bevel 
effect on the data series, and then change the type of bevel or add a custom shadow.
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Note
Unlike most types of Quick Styles, note that Live Preview doesn’t work with Chart Styles 

or Chart Layouts. However, Live Preview does work in charts that are objects on a work-

sheet for formatting options in the Shape Styles and WordArt Styles groups of the Chart 

Tools Format tab.

A key change to remember for chart formatting is that charts are now drawing objects. 
You can select a data series or a data point, for example, and then on the Chart Tools 
Format tab, shown in the following image, customize the formatting by using options 
in the Shape Styles group. You can also use the new WordArt Styles (also on the Chart 
Tools Format tab) to enhance the formatting of chart text. 

Note that, if you customize formatting for individual chart elements after applying a 
Chart Style, you can reset the formatting of just that element of the style without affect-
ing other customizations. To do this, select the element to reset and then, on either the 
Chart Tools Format tab or the Chart Tools Layout tab, in the Current Selection group, 
click Reset To Match Style. To reset multiple elements at once, select the Chart Area and 
then click Reset To Match Style.

 
The various types of Quick Styles for graphics, from Chart Styles to SmartArt Styles to 

Shape Styles, are the places where you see Theme Effects really go to work.

Though you will see different defaults for graphic formatting options (such as shape bor-

ders) depending on your active Theme, apply a Quick Style that contains some type of 

3-D formatting, and then point to various Theme Effects (in the Themes group on the 

Page Layout tab) to see live previews of what Theme Effects can really do for your 

graphics. 

In the case of charts, try changing Theme Effects after applying a Chart Style that 

includes Bevel formatting for the data series.

Note
Unlike most types of Quick Styles, note that Live Preview doesn’t work with Chart Styles 

or Chart Layouts. However, Live Preview does work in charts that are objects on a work-

sheet for formatting options in the Shape Styles and WordArt Styles groups of the Chart

Tools Format tab.

SIDE OUT Use Theme Effects with Chart Styles

The various types of Quick Styles for graphics, from Chart Styles to SmartArt Styles to

Shape Styles, are the places where you see Theme Effects really go to work.

Though you will see different defaults for graphic formatting options (such as shape bor-

ders) depending on your active Theme, apply a Quick Style that contains some type of 

3-D formatting, and then point to various Theme Effects (in the Themes group on the 

Page Layout tab) to see live previews of what Theme Effects can really do for your 

graphics. 

In the case of charts, try changing Theme Effects after applying a Chart Style that 

includes Bevel formatting for the data series.
Chapter 15
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Note
Notice that you now have 3-D Format settings, such as Bevel options, for two-dimen-

sional (2-D) charts. These are very different effects from using a 3-D chart type. Though 

3-D chart types can change the perspective from which you look at the chart, 3-D For-

mat settings simply add depth to individual chart elements.

Customizing Chart Elements
The Chart Options dialog box is no more. In its place is the Chart Tools Layout tab, 
shown in the following image, where you can access any chart element. 

Before you begin to work with the Chart Tools Layout tab, however, keep one important 
shortcut in mind. As you might already know from previous versions, to delete any 
chart element—from gridlines to data series—just select that element on the chart and 
then press the DELETE key. (Note that, for charts on their own sheet, if you paste data 
back on the chart after deleting it, you will no longer be able to delete elements just by 
pressing the DELETE key. You can, however, right-click and then click Delete.)

With the exception of deleted data series or data points, deleted chart elements aren’t 
actually gone. They’re simply not shown. So, you can select the chart element you need 
from the Chart Tools Layout tab at any time, such as with the Axes options that you see 
here. 

Note
Notice that you now have 3-D Format settings, such as Bevel options, for two-dimen-

sional (2-D) charts. These are very different effects from using a 3-D chart type. Though 

3-D chart types can change the perspective from which you look at the chart, 3-D For-

mat settings simply add depth to individual chart elements.
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In fact, if you customize a chart element and then delete it, you can later restore it from 
the Chart Tools Layout options and your customizations will be intact. For help replac-
ing deleted chart data, see the section of this chapter titled “Timesaving Techniques for 
Adding or Editing Chart Data.”

Note
If you select the plot area and then press DELETE, any formatting applied to the plot area 

disappears, but the plot area itself always remains. 

At the bottom of each menu of options for the various chart elements shown on the 
Chart Tools Layout tab, click More <Chart Element> Options to open the Format dialog 
box for that chart element. You can also access the same Format dialog box from the 
shortcut menu that appears when you right-click a chart element.

Additionally, if a chart element is diffi cult to select, select it from the drop-down list in 
the Current Selection group on either the Chart Tools Layout or Chart Tools Format 
tabs. In that same tab group, you can then click Format Selection (if needed) to open 
the appropriate dialog box for your selection.

When you get into those Format dialog boxes, you’ll fi nd several new options, such as 
Shadow options and new Fill, Line Color, and Line Style options that are available to 
many chart elements. For details on how to set specifi c options, such as the new Stop 
settings for gradient lines or fi ll, see Chapter 18, “Creating Professional Presentation 
Graphics.” Though that chapter is in the Microsoft Offi ce PowerPoint 2007 portion of 
this book, the details of these settings apply to all drawing objects that have the capa-
bilities of the new graphics engine. 

Note
One of the nicest new features of the Format dialog boxes is that they’re modeless. That 

is, you can open a Format dialog box for any chart element and then leave it open as you 

select different chart elements for which to make changes. As your selection changes, 

the options in the dialog box change to match. This new functionality helps to explain 

why there’s no Cancel button in the Format dialog box—formatting is applied as soon as 

you set it, so that you can move on to something new. However, you can undo actions 

even while a Format dialog box is open. Just click on the sheet and then either click Undo 

on the Quick Access Toolbar or press CTRL+Z. Then, select a chart element and click back 

into the dialog box to continue formatting.

Note
If you select the plot area and then press DELETE, any formatting applied to the plot area

disappears, but the plot area itself always remains.

Note
One of the nicest new features of the Format dialog boxes is that they’re modeless. That

is, you can open a Format dialog box for any chart element and then leave it open as you 

select different chart elements for which to make changes. As your selection changes,

the options in the dialog box change to match. This new functionality helps to explain

why there’s no Cancel button in the Format dialog box—formatting is applied as soon as 

you set it, so that you can move on to something new. However, you can undo actions

even while a Format dialog box is open. Just click on the sheet and then either click Undo 

on the Quick Access Toolbar or press CTRL+Z. Then, select a chart element and click back

into the dialog box to continue formatting.
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In addition to the new graphic formatting options, the following subsections address 
key points to keep in mind about some other new formatting options as well as a few 
old standards.

Chart Text
Rule number one for formatting text in charts: the Chart Area is the container for all 
chart elements. When you want your font formatting—whether it’s traditional font for-
matting or WordArt formatting—to apply to all text in all elements of the chart, select 
the Chart Area before applying the settings you need.

 Font settings are not available from the Format dialog boxes for any chart ele-
ment. Instead, use the Font group on the Home tab for most settings (or fi nd Font 
on the shortcut menu when you right-click a chart element that contains text). 
You can also use the Alignment group on the Home tab for text alignment and 
orientation (angles), though some of these settings are available from the Format 
dialog boxes. Additionally, click the dialog launcher at the bottom-right of the 
Font group for a pleasant surprise. 

In the Font dialog box available to charts, notice several welcome formatting ad-
ditions, including Small Caps, All Caps, Equalize Character Height, and Offset 
percentage for the Superscript and Subscript settings. You also get a wide range of 
underline styles and the ability to change the color of underlines. Even more fun 
is the Character Spacing tab, shown here, where you can expand and condense 
spacing for chart text.

These font improvements are a benefi t of the new graphics engine. So, in Excel, 
they’re only available to charts and other drawing objects, and not to worksheet 
cells. You’ll fi nd these same font formatting improvements available to any text 
content in Offi ce PowerPoint 2007. 

Note
Among all of the additions to the Font dialog box for chart text, one deletion is worth 

noting. The often frustrating Auto Scale setting for text is, thankfully, gone. So, your 

chart text will no longer shrink to oblivion when you resize the chart.

Note
Among all of the additions to the Font dialog box for chart text, one deletion is worth

noting. The often frustrating Auto Scale setting for text is, thankfully, gone. So, your

chart text will no longer shrink to oblivion when you resize the chart.

 Fighter-Pilot Cool Chart Formatting 321

Ch
ap

te
r 1

5



 As mentioned earlier, also remember that text in charts can now be formatted as 
WordArt. Using the WordArt Styles group on the Chart Tools Format tab (see the 
following image), you can select a preset style or customize fi ll, line, and effects 
with very similar options to shapes.

In the WordArt Styles group, notice that fi ll options include picture, gradient, 
and texture fi lls. Keep in mind that these options refer to the fi ll of the actual text 
characters themselves (such as the text of axis labels). In contrast, if you select a 
fi ll style from the Format Axis dialog box, the text area that contains each axis 
label is formatted with that fi ll.

Note
To wrap text within any label automatically generated from source data (such as an axis 

label or data label), the text must use line breaks in the source data. To do this, in the 

cell where the source data appears, press ALT+ENTER to insert a line break wherever you 

want the text to break to a new line in the chart. However, in an axis title, data label, or 

text box that you edit by clicking in the box and typing, press SHIFT+ENTER to create a 

line break.

Axes
Understanding different types of axes is one of the easiest ways to understand different 
chart types. There are, essentially, two types of axes—category and value—explained as 
follows.

 A category axis can be either a date axis or text axis (known as time-scale axis 
and category axis in earlier versions). Category axes are typically used by charts 
containing two or more axes, which track values across categories—such as track-
ing sales for the past four quarters, which you might do with a column, line, or 
bar chart. These are often referred to as category-value charts and they include 
the majority of built-in chart types available in Excel, including column, line, bar, 
area, stock, and surface charts.

Note
To wrap text within any label automatically generated from source data (such as an axis 

label or data label), the text must use line breaks in the source data. To do this, in the 

cell where the source data appears, press ALT+ENTER to insert a line break wherever you

want the text to break to a new line in the chart. However, in an axis title, data label, or 

text box that you edit by clicking in the box and typing, press SHIFT+ENTER to create a

line break.

Chapter 15
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 A value axis enables you to plot a range of values. Values can be plotted across 
categories, such as in the chart types referenced in the preceding bullet. Or, val-
ues can be plotted relative to other values—such as to compare salary increases 
relative to length of employment, as you can do with a scatter chart. Built-in Excel 
value-value chart types include scatter and bubble charts. 

Similar to a value-value chart, a radar chart contains just one value axis, plot-
ting all values relative to a center point to show variance from the center value. 
Though this chart type has just one axis, that axis appears separately for each 
data series, radiating out from the center, as you see in the following image. The 
axis labels can only appear once, but the line running from the center point to 
each category label (Q1 through Q4) is the same value axis.

Note
Pie charts and donut charts don’t plot values along an axis. Rather, they show contribu-

tions to a whole. A donut chart is used when you need to show the type of relationship 

you would with a pie chart, but using multiple data series.

In the Axes options on the Chart Tools Layout tab, shown in the following image, notice 
that Excel refers to axes as vertical and horizontal, indicating where they appear on the 
chart rather than the axis type. 

Note
Pie charts and donut charts don’t plot values along an axis. Rather, they show contribu-

tions to a whole. A donut chart is used when you need to show the type of relationship 

you would with a pie chart, but using multiple data series.
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However, if you point to an axis, a ScreenTip specifi es horizontal or vertical as well as 
category or value.

Note
The terms horizontal axis and x-axis are used somewhat interchangeably in this chapter 

because x-axis is a common charting reference that generally refers to the same chart 

element being referred to by Excel as the horizontal axis. Keep in mind that horizontal/

vertical, x-axis/y-axis, and category/value aren’t necessarily synonymous. For example, a 

bar chart is a category/value chart, but its value axis is the horizontal axis. Similarly, both 

the x-axis and y-axis for a scatter chart are value axes.

The quick-access options on the Chart Tools Layout tab for displaying a given axis vary 
by axis type (category or value). For additional axis customizations, open the Format 
Axis dialog box.

On the Axis Options tab of the Format Axis dialog box, shown in the following image 
for a value axis, you have virtually the same options as are available from the Scale tab 
of the Format Axis dialog box in the previous version, as well as some options available 
on the Patterns tab in earlier versions. 

Note
The terms horizontal axis and x-axis are used somewhat interchangeably in this chapter

because x-axis is a common charting reference that generally refers to the same chart 

element being referred to by Excel as the horizontal axis. Keep in mind that horizontal/

vertical, x-axis/y-axis, and category/value aren’t necessarily synonymous. For example, a 

bar chart is a category/value chart, but its value axis is the horizontal axis. Similarly, both

the x-axis and y-axis for a scatter chart are value axes.
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CAUTION!
Though it’s common to need to customize the scale—the maximum and minimum val-

ues—on an axis (and this can often be a good idea, as mentioned earlier), remember that 

those values become static once you customize them. Axis Options set to Auto change 

automatically when content in your data requires it; those set to Fixed remain static re-

gardless of changes to the source data. So, for example, say that you have values ranging 

from 50 to 100, and you customize your value axis accordingly with 100 as the maximum 

value. If you then add data to your chart and new values exceed 100, those values won’t 

be visible on your chart. 

Customizing axes is often an important step in displaying your data effectively. Just 

remember to update a customized axis scale if changes to the data require it.

In addition to Axis Options, notice some new formatting capabilities for axes, including 
the following.

 Fill options refer to the fi ll of the text box area around each axis label. 

 Shadow settings affect the line itself. If you apply a fi ll to the axis labels, the shad-
ow setting is applied individually to each axis label area as well.

As you format any chart element, remember (as mentioned earlier) that these objects are 
now seen as drawing objects by Excel. So, you can also format line and fi ll settings for 
the axis or its labels by using the Shape Fill, Shape Outline, and Shape Effects settings 
on the Chart Tools Format tab. You can also use the WordArt styles settings on the 
same tab to format axis label text.

With all of the great new formatting capabilities, however, it’s worth noting that a 
couple of settings in the Format Axis dialog box (as well as the Format dialog boxes for 
some other chart elements, as indicated) have simply been misplaced. 

 A 3-D Format tab appears in the Format Axis dialog box, but the options available 
on that tab are unlikely to have any visible effect on the selected axis. 

 A Vertical Alignment option is available on the Alignment tab of the Format Axis 
dialog box as well as the Format dialog boxes for several chart elements contain-
ing text (Vertical Alignment changes to Horizontal Alignment if you rotate or 
stack the label text.) Though this option appears to be a new addition that enables 
you to align multiline labels within the text area, it doesn’t work as expected. This 
option works with text boxes and other text-enabled drawing shapes that you can 
add to a chart, but it doesn’t work for text within chart elements.

C U O !

 Fighter-Pilot Cool Chart Formatting 325

Ch
ap

te
r 1

5



 
You can visually group categories together on any category axis just by adding a second 

row or column of axis labels in your data.

For example, say that you want to look at revenue by salesperson. You might want to 

group those salespeople by region, as you see on the category axis in this simple

example.

The groups in the preceding image (North America and Europe) are created by adding a 

column to the left of your category axis labels (or a row above your category axis labels, 

if data is in rows), where the category name appears before the fi rst axis label to which it 

applies. For example, the data below corresponds to the preceding chart example.

TROUBLESHOOTING
The last date doesn’t appear on my line chart x-axis
When you need the last date to appear as the last axis label on a line chart, you can 

usually do that with some trial and error. To remove the trial and error, you just need to 

change that line chart to a scatter line and then specify a few values in the Axis Options. 

But, let me fi rst give you a bit of background and explain your choices. 

A line chart’s horizontal axis is a category axis. So, whether you use the Date Axis or Text 

Axis option in the Format Axis dialog box, you need to change the number of data points 

between each label to manipulate which labels appear on the axis. In the case of a Date 

Axis, change the Major Unit; for a Text Axis, change the settings for Intervals Between 

Labels. 

SIDE OUT Group a category axis

You can visually group categories together on any category axis just by adding a second

row or column of axis labels in your data.

For example, say that you want to look at revenue by salesperson. You might want to 

group those salespeople by region, as you see on the category axis in this simple

example.

The groups in the preceding image (North America and Europe) are created by adding a

column to the left of your category axis labels (or a row above your category axis labels, 

if data is in rows), where the category name appears before the fi rst axis label to which it 

applies. For example, the data below corresponds to the preceding chart example.

TROUBLESHOOTING
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There is, however, a simple calculation you can use to remove the guesswork. The prob-

lem with a line chart is that the result will only work if it’s a whole number. But, stick with 

me—this formula will help you regardless.

To calculate the Major Unit or Interval Between Labels, type the following formula, sub-

stituting your own values: =(last date – fi rst date)/one less than the number of axis 
labels you want. Remember that the fi rst and last dates, even if formatted as dates, are 

still numbers. For example, if you take the publication date of this book (2/1/2007) and 

change the number format in Excel to Number, that value would appear as 39114. 

If the result of the formula is a whole number, then the easiest solution is to select Text 

Axis and use that formula result as the values for both Intervals Between Tick Marks and 

Intervals Between Labels. You can also use it with a Date Axis as the Major Unit, setting 

the unit of measure to Days. However, if the formula result is not a whole number, your 

resulting axis is likely to be off and you won’t get the last axis label you need. So, you can 

continue trying different numbers of axis labels for the last argument in the formula, or 

you can change your line chart to a scatter line, and do this without issue. 

When you change your line chart (or line series in a combination chart) to an XY Scatter 

Chart With Straight Lines (with or without markers), the line might change dramatically, 

covering only a portion of the plot area. Don’t be concerned, that’s just because you 

need to set up the horizontal axis—which is now a value axis.

To do this, use the fi rst date and last date in your data, in number formats (as mentioned 

above) as the Minimum Value and Maximum Value. Then, use the result of the formula 

given earlier in this tip as the Major Unit. If the formula result exceeds seven decimal 

places, make sure that you’re seeing all decimal places before you use the result as the 

Major Unit value. (General number format, for example, rounds results to eight decimal 

places, which may provide an inaccurate result as the Major Unit.) With no trial and error, 

you’ll then have exactly the line chart you need, with an axis that shows the exact dates 

you want and with the exact number of axis labels you need.

Check out the Webcast titled “Advanced Tips and Tricks for Fast and Fabulous Excel 2007 

Charts” on the Expert Tips tab of this book’s CD for a live demo of these steps as well as 

many other tasks discussed in this chapter.

Gridlines
The new line style options available to other chart elements, such as axes, are available 
to gridlines as well. However, if you choose Gradient Line on the Line Color tab of the 
Format Gridlines dialog box, the gradient will progress from the top gridline to the bot-
tom gridline (or the left gridline to the right gridline) rather than gradient changes tak-
ing place within each individual line.
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Chart and Axis Titles
The most notable change for titles is simply that there is no longer a dialog box in which 
to edit their text. Otherwise, their behavior is much the same with some improved for-
matting options discussed in the section titled “Chart Text” earlier in this chapter. 

Titles are now always inserted with placeholder text, which you can click in and edit 
like any text box, or select and then click in the Formula bar to link the title to a cell 
value.

You can link the text boxes for titles, data labels, or custom text boxes inserted on a 
chart to cell values in the workbook. To do this, select the title, label, or text box, and 
then click in the Formula bar. Type =Your Cell Address, remembering to specify the 
sheet name if the reference is on a different sheet. Rather than worrying about syntax, 
the easiest way to link the selected box to a cell value is to type the equal sign in the 
Formula bar and then browse to the cell, select it, and press ENTER to apply the link.

Combining Chart Types
Combining chart types, such as when you want to display some chart series as columns 
and others as lines, is very easy to do. You just start with the chart type you want for the 
majority of series, and then select each series you want to change to another chart type 
and select the new chart type you need. For example, if you want a chart with two col-
umn series and one line series, do the following.

 1. Create a column chart.

 2. Select the data series that you want to display as a line chart and then, on the 
Chart Tools Design tab, click Change Chart Type.

 3. Select the chart type for the selected series and then click OK. 

If a single data series is selected when you open the Change Chart Type dialog 
box, only the selected series will be affected.

Where things get a bit more complicated is when different chart types require different 
types of axes. An excellent example of this is a price/volume chart, where the volume 
is displayed in columns and the price as a scatter line. A scatter line is used instead of a 
line chart for the price series to control the appearance of the last date on the horizontal 
axis, as discussed in the Troubleshooting tip titled “The last date doesn’t appear on my 
line chart x-axis” earlier in this chapter. Review the detailed instructions  for creating 
this chart type in the section of this chapter titled “Price/Volume Charts” and apply 
the techniques discussed there for working with mixed axes requirements to any chart 
type where this issue presents itself.

Using Secondary Axes
When different chart series have extremely different values—such as when one series 
shows sales volume and the other shows year-over-year percentage change in sales—you 
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are likely to need to show those series on different value axes to be able to see them 
both effectively at the same time.

To assign a series to a secondary value axis, right-click the series and then select For-
mat Data Series. On the Series Options tab, select Secondary Axis from the Plot Series 
On options. If you have many series in your chart, assign each to the most appropriate 
value axis. 

Note
When different series require different types of x-axes (category or value), you can’t mix 

their vertical (value) axis assignments. That is, if you have two scatter series, for example, 

and one column series, both scatter series will need to be plotted on the same axes be-

cause scatter charts and column charts require different types of x-axes.

Note that, if you change the chart type of a series to one that requires a different type 
of x-axis (such as changing a line series to a scatter line so you can get a value x-axis, as 
discussed earlier), the series with the unique x-axis type requirement is automatically 
plotted on a secondary value axis, and a secondary x-axis (be it value or category, as 
needed) appears on the chart. Secondary x-axes usually appear, by default, across the 
top of a chart. To see a detailed example of options for dealing with the appearance and 
placement of multiple axes, see the section of this chapter on price/volume charts. 

TROUBLESHOOTING
One column or bar series is hidden behind another
When you add a secondary value axis for one or more series of a column or bar chart, 

some series might become hidden behind others. This is because each value axis plots its 

series independently, so Excel sees the series on each of those axes as being independent 

of the others—as if they were separate charts.

Changing Gap Width settings on the Series Options tab of the Format Data Series dialog 

box can enable you to see hidden series by making those in front appear narrower than 

those in back, but the Overlap setting on the Series Options tab doesn’t apply to series 

plotted on separate axes. To see the series side by side, you need to use a workaround—

and though it isn’t the neatest workaround you’ll ever see for a feature, it will get the job 

done. To see the series side by side, follow these steps.

 1. Add two series to the chart containing all zero values—we’ll call them space series. 

(Note that just one space series might be required in some cases, but I fi nd it 

usually takes less trial and error when you use two.)  

Note
When different series require different types of x-axes (category or value), you can’t mix 

their vertical (value) axis assignments. That is, if you have two scatter series, for example,

and one column series, both scatter series will need to be plotted on the same axes be-

cause scatter charts and column charts require different types of x-axes.

TROUBLESHOOTING
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 2. If you’re showing the legend, right-click each space series label in the legend and 

then click DELETE. Notice that you now have separate options when you right-click 

here for Delete or Delete Series, so you don’t need to worry about deleting a series 

when you delete its label from the legend.

 3. Move one of the space series to the secondary axis. If this doesn’t move your 

visible series side by side and centered between tick marks, reorder the series until 

you get the effect you need.

 4. To reorder data series, on the Chart Tools Design tab, click Select Data. In the box 

labeled Legend Entries (Series), select the series to move and then click the Move 

Up or Move Down arrows. Notice that settings in this dialog box don’t update until 

you close the dialog box. So, you might need to revisit this dialog box a couple of 

times to get the exact result you want.

TROUBLESHOOTING
The axis assignment shown in the Format Data Series dialog box is incorrect
If you assign a series to a secondary axis and later open the Format Data Series dialog 

box to fi nd that the Plot Series On options are set to Primary Axis and unavailable, you 

might be encountering a bug. 

As of press time for this book, a bug was present that would cause the incorrect value 

axis assignment to appear in the Format Data Series dialog box and make that assign-

ment unavailable. This issue only occurs when chart types that require different types of 

x-axes (that is, mixed category and value x-axes) are combined.

As long as you can see by looking at the chart that the series is plotted on the axis you 

need it to be, don’t worry about an incorrect axis assignment being indicated in the dia-

log box. It won’t affect the behavior of your chart.

Adding Drawing Objects to Charts
When you need a shape, a text box, or an image on your chart (such as a text box to an-
notate a particular date in the chart), just select the drawing object you need from the 
Insert group on the Chart Tools Layout tab or the Illustrations group of the Insert tab.

Simply insert the shape or picture you need as you would on a worksheet. You can then 
select a shape and just begin typing to add text, or just click into a text box to begin 
editing it. As mentioned earlier, remember that you can link a text box to the value in a 
cell on a worksheet. You can do the same with a shape. To do this, start by selecting the 
text box or shape and then do the following.

 1. Click in the Formula bar.

 2. Type =.

TROUBLESHOOTING
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 3. Browse to and select the cell you want to link, and then press ENTER.

You can format a linked text box as needed with one exception—numeric values in your 
linked cell will always display the same number format in the linked text box. There is 
no way to format numbers separately in the text box. Even if the text box you link is a 
chart element (such as a data label), the Number format options in the Format Data La-
bels dialog box won’t apply to values linked using this method.

For other picture, shape, and text box formatting, see Chapter 18. However, one point 
warrants noting here. If you open the Selection And Visibility pane on a chart sheet or 
on a worksheet that contains a chart, the pane recognizes the chart as an object. It does 
not, however, recognize separate shapes or other drawing objects created on your chart. 
This is because your chart itself is a drawing object. Objects created on your chart be-
come a part of the chart. That’s good news, because if you copy your chart to another 
program, for example, you’ll want those objects to come along automatically.

Note that, if you instead paste or drag a graphic onto a chart, it does appear as a sepa-
rate object in the Selection And Visibility pane. Watch out for this because, if it appears 
as a separate object in that pane, it’s not part of the chart—so it won’t come along for the 
ride when you copy that chart to paste it in another location.

 
With all the great new formatting options, it’s nice to know that one of the coolest for-

matting shortcuts from earlier versions of Excel is still available.

Though you can now use a picture as the fi ll for any chart element that has fi ll options, 

you can also paste a picture on just selected data series or individual data points to apply 

the picture as the fi ll for your selection.

Just select and then copy a picture in its source program (the picture itself, not the 

picture fi le). Then, in Excel, select the data series or data point you want to fi ll with the 

picture and paste. For example, copy an image of your company logo from the header of 

a Microsoft Offi ce Word 2007 document and then paste it on the data point that repre-

sents your company in a scatter chart. 

This shortcut isn’t limited just to pictures. You can also copy any Offi ce Art object (such as 

a group of shapes or a Clip Art drawing) and paste it as data point fi ll. Not that you’d ever 

want to do so, but you can even paste a SmartArt diagram as data point fi ll. 

To use pictures as the fi ll for chart elements other than data series or data points, or to 

customize the appearance of picture fi lls for data, use the Fill options in the applicable 

Format dialog box.

SIDE OUT Paste pictures as data points

With all the great new formatting options, it’s nice to know that one of the coolest for-

matting shortcuts from earlier versions of Excel is still available.

Though you can now use a picture as the fi ll for any chart element that has fi ll options,

you can also paste a picture on just selected data series or individual data points to apply

the picture as the fi ll for your selection.

Just select and then copy a picture in its source program (the picture itself, not thet
picture fi le). Then, in Excel, select the data series or data point you want to fi ll with the

picture and paste. For example, copy an image of your company logo from the header of 

a Microsoft Offi ce Word 2007 document and then paste it on the data point that repre-

sents your company in a scatter chart. 

This shortcut isn’t limited just to pictures. You can also copy any Offi ce Art object (such as 

a group of shapes or a Clip Art drawing) and paste it as data point fi ll. Not that you’d ever

want to do so, but you can even paste a SmartArt diagram as data point fi ll.

To use pictures as the fi ll for chart elements other than data series or data points, or to

customize the appearance of picture fi lls for data, use the Fill options in the applicable 

Format dialog box.
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Timesaving Techniques for Adding or Editing Chart Data
As mentioned earlier, when you format your source data as a table, you gain benefi ts for 
the chart, such as the chart automatically updating to refl ect changes in the source data 
range. So, you probably won’t need to make as much use of shortcuts for adding data to 
your chart as you might have in the past. However, using a table in this way isn’t always 
practical—such as when your chart needs to be created from noncontiguous data or 
your table organization doesn’t lend itself to being in a table. With this in mind, follow-
ing are two helpful methods for adding data to a chart.

 When your data is not in an Excel table and the new series you want to add has 
exactly the same confi guration as existing series (that is, it uses the same cells 
within its row or column as all other existing series), you can simply copy the 
new series data and paste it onto the chart. For example, say that your original 
chart takes the data for Regions 1 through 4 from the following range.

To add one or more of the other regions in that data, just select and copy it. Then, 
select the chart where you want to add the data and just paste (CTRL+V). Your 
new series will appear exactly as if it had always been there.

Note
Though pasting data series works in earlier versions, the new series won’t consistently 

take on existing customized chart formatting. This is, fortunately, not the case in Excel 

2007. Your new data will take on whatever applicable formatting is active when the series 

is pasted.

This method, however, isn’t necessarily as easy when adding data points to exist-
ing series or adding new series in a different confi guration than existing series. It 
can also be inconsistent when source data is in an Excel table. In those cases, edit 
the data range using the Select Data Source dialog box.

 When you open the Select Data Source dialog box (through the Chart Tools Lay-
out tab or the shortcut menu available when you right-click the chart), you see 
an option to add data. Don’t use it. Instead, notice that the existing data range is 
highlighted on the worksheet. 

You can simply click in the worksheet while the Select Data Source dialog box is 
open. Just select the revised data range and then press ENTER to apply it. 
(Remember to hold the CTRL key when selecting noncontiguous data.)

Note
Though pasting data series works in earlier versions, the new series won’t consistently 

take on existing customized chart formatting. This is, fortunately, not the case in Excel 

2007. Your new data will take on whatever applicable formatting is active when the series

is pasted.
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 As an alternative to either of the preceding options for adding a data series, try us-
ing the SERIES function. When you select a data series, a formula is created with 
the SERIES function in the Formula bar. That formula has four parts, as shown in 
the following image.

 1. The fi rst argument is for the series name.

 2. The second argument is for the category labels in a category-value chart or the 
x-values in a value-value chart.

 3. The third argument is for the values in a category-value chart or the y-values in a 
value-value chart.

 4. The last argument indicates the position in the series order.

To add a new series using this formula, fi rst copy the formula for any existing 
chart series. To do this, select a series, click into the Formula bar, select the con-
tents of the formula, and then copy (CTRL+C). Then, do the following.

 1. Press ESC twice, so that no series is selected. Then select the Chart Area. Be 
careful not to leave a series selected, or you’ll replace the selected series instead of 
adding a new one.

 2. Click in the Formula bar and then paste (CTRL+V). 

 3. Edit the cell references in the appropriate arguments of the SERIES formula to 
represent the values of the data in your new series.

 4. Press ENTER to add the new series. Don’t press ENTER until after you’ve edited 
the values for the new series (as indicated in the preceding step), or no new series 
will be added.

TROUBLESHOOTING
How can I retrieve lost chart data?
You created a chart with complex data linked to an external source and that data source 

has now disappeared. Of course, if you’re like most people, you probably need to edit 

that source data twenty minutes before an urgent deadline. Fortunately, this isn’t at all 

the disaster you probably expect.

If the chart still displays the data, the chart still knows the data. So, you can use a Micro-

soft Visual Basic for Applications (VBA) macro to extract that data from the chart. I wish I 

had come up with this one, but alas I did not. You’ll fi nd the answer in a Microsoft Knowl-

edge Base article that’s been around for several Microsoft Offi ce versions. 

The article isn’t yet updated (as of this book’s press time) for Excel 2007, but the version 

of the article for Excel 2003 still works without a hitch. The article provides the complete 

macro and detailed instructions for using that macro to extract your data, so you don’t  

 Timesaving Techniques for Adding or Editing Chart Data 333

Ch
ap

te
r 1

5



need to know VBA to use this solution. The article even provides help for linking your 

chart to the new source data.

The Knowledge Base article ID is 300643. To access this article, go to http://support.mi-

crosoft.com and search for the article ID number. You can use either the Search Support 

(KB) option on the Help And Support home page or the Search Microsoft.com For box 

that appears at the top of most microsoft.com pages. 

Reorder Data Series and Set Data Display Options
As mentioned in an earlier Troubleshooting tip, the Select Data Source dialog box is 
the place to go to change the order in which series appear on the chart as well as in the 
chart legend. To change series order, select the series to move from the Legend Entries 
(Series) box in the Select Data Source dialog box and then click the Move Up or Move 
Down arrows as needed.

Note
You can also reorder data series using the SERIES formula that was introduced under the 

preceding heading. Change the value of the fourth argument in the SERIES formula for 

whatever series you want to reorder, and the series numbers for the other chart series 

will automatically adjust to accommodate the change. 

In the Select Data Source dialog box, also notice the option Hidden And Empty Cells. 
When you click that option, you get a dialog box where you can opt to show data on 
the chart from hidden rows and columns included in your source data, and you can set 
options for how to plot empty cells. To learn how to use these options to connect data 
gaps in a line chart, see the Troubleshooting tip that follows.

TROUBLESHOOTING
I need to connect data gaps in a line chart
Excel gives you options for how you want to plot empty cells in the active chart. So, when 

you want a line series to be continuous even when the data includes empty cells, you just 

need to set the option for how you want to plot blank cells (and yes, there is a catch, but 

read on for the solution).

With the chart active, on the Chart Tools Design tab, click Select Data and then click 

Hidden And Empty Cells. The option you want is Connect Data Points With Line. (Note 

that, in previous versions, these settings are available from the Options dialog box on 

the Tools menu, and this option is called Interpolated.) The aforementioned catch is that, 

if any of your data series are not line or similar chart types, this option will be unavailable. 

Note
You can also reorder data series using the SERIES formula that was introduced under the

preceding heading. Change the value of the fourth argument in the SERIES formula for

whatever series you want to reorder, and the series numbers for the other chart series 

will automatically adjust to accommodate the change. 

OU S OO G
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If Connect Data Points With Line is unavailable in the Hidden And Empty Cell Settings 

dialog box, but at least one series in your chart is a line or similar, you can set this prop-

erty using the Immediate Window in the Visual Basic Editor. As mentioned in Chapter 

14, in the Troubleshooting tip about resetting the used range, most of my references to 

using VBA refer you to Chapter 21, “VBA Primer.” However, you don’t need to learn your 

VBA ABCs just to use the occasional quick and easy solution. 

To set Connect Data Points With Line for the line series in a combination chart, press 

ALT+F11 to open the Visual Basic Editor. Then, if you don’t see the Immediate Window at 

the bottom of your screen, press CTRL+G to open it. Click in the Immediate Window and 

then type the following:

ActiveWorkbook.Charts(“Chart Name”).DisplayBlanksAs = xlinterpolated

With your insertion point in the line of code you just typed, press ENTER to apply this 

setting. Note that at least one series in your chart must have the ability to use this setting 

(such as a line, scatter line, or radar chart), or an error message will appear.

Creating Advanced Chart Types
Most complex charts are easy to create. It’s just that the more complex the chart type, 
the more likely it is to require some specifi c choices along the way. Once you under-
stand the concepts behind these choices, you can apply them as needed to a variety of 
chart types.

With that in mind, this section takes you step-by-step through creating  two complex 
chart types. I’ve chosen these two chart types because they so often trip up even confi -
dent, experienced Excel users. The fi rst of these, bubble charts, are a built-in chart type. 
The second, price/volume charts, are combination column and line charts often used in 
the securities industry.

Bubble Charts
A bubble chart is really just a scatter chart with an extra value per data point, so let’s 
fi rst take a look at how you construct a scatter chart.

When you create a scatter chart, each data point is the intersection of two values. For 
example, take a look at the following data.
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The scatter chart shown in the following image is created from the preceding data table. 
Notice that the fi rst column of data becomes the horizontal axis and the second be-
comes the vertical axis.

When you create a scatter chart, don’t select the data labels or series labels—Excel won’t 
understand them. Just select the x and y values. The data labels in the preceding chart 
are created by linking each label to the correct cell—something you’ll see how to do for 
the upcoming bubble chart.

Use a bubble chart when you need to include a third value for each data point. That 
third value appears as the size of the bubble. Following along with the same salary ex-
ample, the bubble might be used to represent each person’s current salary. To do that, 
add a third column of data, as you see in the following graphic, and then sort the data 
table so that the largest bubble value is on top. That sort enables the smaller bubbles to sit 
in front when data overlaps. So, for the previous example, the bubble chart data should 
look like this:

That data results in a bubble chart that looks like the following image.
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Note
If you work in securities and you need a bubble chart for the common use of comparing 

deals across a market segment, set up your data as follows: Use Days Trading Volume as 

your x-values, % Market Cap as your y-values, and Deal Size as your bubble sizes.

Though you can’t add category data labels automatically as part of the chart, you can do 
the following to get that done.

 1. To easily identify each data point, add data labels to the chart that show both the 
x-value and the y-value. To do this, right-click the Data Series and select Add Data 
Labels. Then, right-click the labels and select Format Data Labels. Select the data 
to show on the Label Options tab.

 2. If the amount of overlap between bubbles makes it ineffective to use the Label 
Position setting found on the Label Options tab of the Format Data Labels dialog 
box, move each data label to sit on or beside the corresponding bubble. They’re 
easy to identify because the ScreenTip for each bubble provides its x and y values, 
as well as the bubble size. To move individual data labels, select the data labels 
and then click once on the individual label you want to select. You can then drag 
labels to new positions as needed.

 3. Select the fi rst label to link. In the Formula Bar, type = and then browse to your 
data. Select the cell containing the label for the applicable data point (because you 
can see the x and y values in the label, fi nding the cell’s label should be quick and 
easy) and then press ENTER. Repeat this action for each label as needed.

Price/Volume Charts
A price/volume chart, as advertised earlier in this chapter, is a common chart in the 
securities industry, used to show the daily price and trading volume of a security over a 
period of time.

Note
If you work in securities and you need a bubble chart for the common use of comparing 

deals across a market segment, set up your data as follows: Use Days Trading Volume as 

your x-values, % Market Cap as your y-values, and Deal Size as your bubble sizes.

 Creating Advanced Chart Types 337

Ch
ap

te
r 1

5



For those readers not in the securities fi eld, the value of this chart type is that it’s a com-
bination chart requiring secondary axes, using series that require different types of x-
axes—so you can see several complex types of chart customization managed in a single 
chart.

Note
Find the completed price/volume chart used in the example that follows in the fi le 

named Price Volume.xlsx, available in the sample fi les you can install from the Welcome 

tab of this book’s CD. You can open, examine, or edit that chart for yourself—or use the 

source data to try to duplicate the completed chart on your own. Additionally, the Excel 

webcast available on the Expert Tips tab of the CD (as mentioned earlier in this chapter) 

includes demonstrations of both price/volume and bubble charts.

A price/volume chart commonly contains hundreds of data points—for example, if 
you’re tracking stock performance over an entire year. The sample I’m using tracks per-
formance of our fi ctional sample stock from the beginning of March through the end 
of November. Set up the data just as you might for any category-value chart, with the 
x-axis labels (the dates in this case) in the fi rst column, followed by the data series in 
columns, with the series names at the top of each column. Following is a snippet from 
that data—the full data range is 195 rows long in this case.

Note
You might notice that the data is very much sample data, in that you may see data points 

for dates (such as holidays) when the market is not open.

Note
Find the completed price/volume chart used in the example that follows in the fi le

named Price Volume.xlsx, available in the sample fi les you can install from the Welcome

tab of this book’s CD. You can open, examine, or edit that chart for yourself—or use the 

source data to try to duplicate the completed chart on your own. Additionally, the Excel 

webcast available on the Expert Tips tab of the CD (as mentioned earlier in this chapter) 

includes demonstrations of both price/volume and bubble charts.

Note
You might notice that the data is very much sample data, in that you may see data points 

for dates (such as holidays) when the market is not open.
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To create the chart, do the following.

 1. Select the data, including x-axis labels and series titles, and then press F11 to 
create the default chart type on its own sheet. If your default chart type isn’t a 
clustered column chart, change the chart type to a clustered column chart. (As 
mentioned earlier, access the Change Chart Type dialog box on the Chart Tools 
Design tab.)

 2. Select the volume series and then open the Format Data Series dialog box. 
Change the Plot Series On setting to Secondary Axis. 

If the series is diffi cult to select, remember that you can select the series using 
the drop-down list in the Current Selection group on the Chart Tools Layout or 
Format tabs, and then open the dialog box from that same group. (Or, select the 
series name in the legend and then right-click for the Format Data Series option.) 
You need to place the volume series on the secondary axis because the x-axis for 
the price series is the one you’ll want to display on the chart—so plotting the price 
series on the primary axis makes that quicker and easier to do.

 3. Select the price series (because the price series won’t be easy to see as yet, you’ll 
most likely need to use the Current Selection group to do this). Then, on the 
Chart Tools Design tab, click Change Chart Type and select Scatter With Straight 
Lines as the chart type for the selected series. You’ll then be able to see the price 
series as a line, but it most likely won’t stretch across the entire plot area. This is 
because you need to customize the x-axis values.

Note
When creating a chart of this type, selecting a scatter line instead of a typical line chart 

enables you to ensure that the last date in your data appears on the x-axis without trial 

and error, as explained in the Troubleshooting tip referenced in the next step. 

 4. Set the Minimum, Maximum, and Major Unit values for the primary x-axis so 
that the last date in your data appears as the last axis label. The Minimum and 
Maximum values are the fi rst and last dates in your data, respectively, expressed 
as numbers. The Major Unit is the result of the calculation provided in the 
Troubleshooting tip titled “The last date doesn’t appear on my line chart x-axis” 
earlier in this chapter.

It’s worth noting that, when you use this method to show the last date on the x-
axis, all dates in the data range are included in the x-axis and not just those for 
which the market is open. This isn’t typically considered a problem because the 
dates did occur in the time period being displayed. But, it’s good to be aware that 
your x-axis labels might include dates for which there are no corresponding price 
or volume values. 

Note
When creating a chart of this type, selecting a scatter line instead of a typical line chart 

enables you to ensure that the last date in your data appears on the x-axis without trial

and error, as explained in the Troubleshooting tip referenced in the next step.
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 5. Customize the y-axes as needed. For example, in the sample chart, all price data 
ranges between 30 and 55, so I fi x the Minimum value at 30 and the Maximum
at 55.

 6. To remove any unwanted gaps in the volume data that might occur because all 
dates aren’t included in true stock data (which usually excludes weekends and 
holidays), you’ll need to change the category axis type for the volume series 
to a Text Axis. To do this, on the Chart Tools Layout tab, click Axes, point to 
Secondary Horizontal Axis, and then click Show Left To Right Axis. The axis will 
appear across the top of the chart, and your volume series will fl ip upside down. 
Don’t panic! Open the Format Axis dialog box for this axis and then select Text 
Axis as the Axis Type. While you’re in this dialog box, set all tick mark and axis 
label type options to None, and on the Line Color tab, select No Line. Close the 
dialog box.

 7. Open the Format Axis dialog box for the secondary y-axis (the one on which the 
volume series is plotted). On the Axis Options tab, under the heading Horizontal 
Axis Crosses, click Axis Value and then type a zero. Click OK. Your volume series 
should now be right-side up once again. 

 8. You can now apply any Chart Style or other formatting you want to perfect your 
chart. That’s all there is to it. Your completed chart, if you’re using the sample 
data available on the CD, should look something like the image that follows. 

See the following Inside Out tip to learn how to get the currency symbol on the top la-
bel for the primary vertical axis.
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When you want to customize the number format of individual value axis labels, such as 

the currency symbol on the top label of the primary vertical axis in the price/volume 

chart shown in this section, do the following.

 1. Select the axis to customize and then open the Format Axis dialog box.

 2. On the Number tab of that dialog box, select Custom. 

 3. In the Format Code text box, type the custom format you want. To specify a 

format for just one value, start by typing that value inside brackets, following an 

equal sign. After the closing bracket, type the format for that value followed by a 

semicolon. After the semicolon, type the format for all other values. For example, 

the custom number format used in the sample price/volume chart’s primary 

vertical axis looks like this:

You can examine this example for yourself in the sample fi le Price Volume.xlsx 

mentioned earlier.

Note that, for custom number formats, a zero is used when you want to ensure 

that the digit will appear—use a pound sign when you only want a digit to appear 

if used by the number. For example, if you set up a number format as 0,000, the 

number 325 would appear as 0,325. If you set up the format as #,##0, the number 

will appear as 325.

You can have more arguments than the two used in this example. For each value 

for which you want to specify a format, start with the number in brackets after an 

equal sign and follow the close bracket with the format. Separate each argument 

with a semicolon. Where you see two arguments in a number format but no speci-

fi ed values, the second argument refers to negative values. 

 4. Click Add once you’ve fi nished typing in the custom format and then click OK. 

Click OK when done.

To apply the format to your axis, you must take the step to add it to the custom list. 

Remember that this custom format is static to the specifi c value you indicate. So, if the 

SIDE OUT Create a custom number format for specifi c values on a
chart axis

When you want to customize the number format of individual value axis labels, such as

the currency symbol on the top label of the primary vertical axis in the price/volume

chart shown in this section, do the following.

1. Select the axis to customize and then open the Format Axis dialog box.

2. On the Number tab of that dialog box, select Custom.

3. In the Format Code text box, type the custom format you want. To specify a

format for just one value, start by typing that value inside brackets, following an 

equal sign. After the closing bracket, type the format for that value followed by a 

semicolon. After the semicolon, type the format for all other values. For example,

the custom number format used in the sample price/volume chart’s primary 

vertical axis looks like this:

You can examine this example for yourself in the sample fi le Price Volume.xlsx

mentioned earlier.

Note that, for custom number formats, a zero is used when you want to ensure

that the digit will appear—use a pound sign when you only want a digit to appear 

if used by the number. For example, if you set up a number format as 0,000, the 

number 325 would appear as 0,325. If you set up the format as #,##0, the number 

will appear as 325.

You can have more arguments than the two used in this example. For each value 

for which you want to specify a format, start with the number in brackets after an

equal sign and follow the close bracket with the format. Separate each argument

with a semicolon. Where you see two arguments in a number format but no speci-

fi ed values, the second argument refers to negative values. 

4. Click Add once you’ve fi nished typing in the custom format and then click OK.

Click OK when done.

To apply the format to your axis, you must take the step to add it to the custom list. 

Remember that this custom format is static to the specifi c value you indicate. So, if the 
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scale for the applicable axis changes, you might need to change the specifi ed value. 

Notice that, once you’ve added a custom format, it becomes part of the list in the active 

workbook so that you can use it again. Custom number formats that you save for chart 

formatting are available for use by any  chart in any open workbook, as long as the work-

book containing that format is open.

Creating Charts for Use in Other Programs
Though you can now create Excel charts directly in Offi ce Word 2007 or PowerPoint, 
you might still want to create and manage them in Excel in order to keep all data and 
charts related to one document or presentation together in a single workbook. 

Also, as discussed in the Word part of this book, in Chapter 7, “Managing Graphics,” 
creating graphics in their originating program and then pasting them into Word as 
pictures (instead of leaving live graphics in your document) can help you keep private 
source data private and help you ensure that the chart you send is the chart all recipi-
ents see.

Because you can create Excel charts in Word or PowerPoint, when you paste an Excel 
chart into either of those programs using the default paste method (CTRL+V), it re-
mains a live chart linked to the source data. To embed the entire workbook (watch out 
for private data in the source workbook if you do this) or to paste as a picture, you can 
choose from the paste SmartTag that appears after you paste the chart. However, for 
best results when you want to paste as a picture, use Paste Special instead (as described 
later in this chapter) so that you can control the picture type.

Because pasting as a picture is the most secure way to go, particularly for your Word 
documents, that’s the method that I discuss in the sections that follow. You can use the 
resizing and copy steps, however, regardless of what paste method you prefer. 

Resizing Charts
Resizing charts wasn’t ever as diffi cult as people often assumed, but it’s never been this 
easy. On the Chart Tools Format tab, just specify the height and width for the chart. 
Some reformatting might be required for substantial reductions in chart size—most of 
which can be quickly accomplished by just reducing font size throughout the chart.

Note
If the legend disappears when you resize a chart, on the Chart Tools Layout tab, click 

Legend and then click an option to show the legend at a specifi c position on the chart. 

The legend will pop back into place on your resized chart, and you can then move or 

customize it as needed.

Note
If the legend disappears when you resize a chart, on the Chart Tools Layout tab, click

Legend and then click an option to show the legend at a specifi c position on the chart. 

The legend will pop back into place on your resized chart, and you can then move or

customize it as needed.

scale for the applicable axis changes, you might need to change the specifi ed value.

Notice that, once you’ve added a custom format, it becomes part of the list in the active

workbook so that you can use it again. Custom number formats that you save for chart 

formatting are available for use by any chart in any open workbook, as long as the work-

book containing that format is open.
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When a chart is on its own sheet, the sheet size will remain the same and the chart area 
will reduce when you resize the chart. If the chart itself becomes too small within the 
chart area, select the plot area and drag to expand its size so that the plot area uses the 
maximum available space within the chart area. Also remember to zoom in on charts 
after you resize them to be smaller, so that you can see all elements as accurately as pos-
sible. Object appearance in Excel does become more accurate when you zoom in.

Getting Your Chart into Word
If that chart is destined for a Word document, it’s likely that you’ve used a table cell as 
the placeholder for the chart. If you aren’t familiar with how and why to use tables as 
page layouts, see Chapter 6, “Tables.”

 1. If you are using a table cell as a placeholder, click in the placeholder cell in your 
Word document and then, on the Table Tools Layout tab, note the width and 
height of the cell.

 2. Back in Excel, select the chart and then, on the Chart Tools Format tab, enter 
the placeholder table cell’s height and width measurements as the chart height 
and width. Then, as mentioned in the preceding section of this chapter, adjust 
formatting if needed.

 3. Select the chart area and then copy (CTRL+C).

 4. In Word, click in the placeholder table cell and press CTRL+ALT+V to open 
the Paste Special dialog box. Select either Picture (PNG) or Picture (Enhanced 
Metafi le) as the picture type and then click OK.

As discussed in Chapter 7, PNG and Enhanced Metafi le are usually the best pic-
ture formats when pasting Excel content into Word. If you aren’t happy with your 
results with one of these picture types, try the other, as results with these picture 
formats can vary depending on the particular chart’s formatting. Also as noted 
in Chapter 7, the chart size you set in Excel may be altered very slightly after you 
paste the chart into Word. If so, you can make the adjustment in the Size group 
on the Picture Tools Format tab.

 5. If your default paste format for pictures in Word is not In Line With Text, right-
click the picture, point to Text Wrapping, and then click In Line With Text. The 
picture will fall perfectly into place.
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Note
If you want to paste your picture as an Enhanced Metafi le, you can use the Copy As Pic-

ture tool in Excel in place of step 3 in the preceding steps. Using Copy As Picture instead 

of just copying your chart with CTRL+C ensures that you won’t risk pasting an unwanted 

embedded or linked object. The downside to Copy As Picture is that PNG is not an avail-

able paste format in the destination 2007 release program when you use this method.

To use Copy As Picture, select the chart and then, on the Home tab, click to expand Paste 

options, point to As Picture, and then click Copy As Picture. In the Copy As Picture dialog 

box, shown here, the Appearance option As Shown On Screen usually provides the better 

results. Use the Picture option for Picture (Enhanced Metafi le) to be an available Paste 

Special option in the destination program. 

Getting Your Chart into PowerPoint
You can use the same copy and paste steps for Word when you want to get your Excel 
chart into PowerPoint as a picture. If you want to know the size available on your slide 
in order to resize the chart before copying it, create a rectangle on the slide in the size 
you want the chart and take its measurements from the Drawing Tools Format tab. 

However, because PowerPoint and Excel have similar graphics capabilities, there’s not 
quite as much reason to paste Excel charts into PowerPoint as pictures as there is when 
using those charts in Word. Unless you want to keep all data for your presentation in 
one workbook (which is a nice idea for effi cient editing) or you will be sharing the Pow-
erPoint fi le with others who should not edit the chart or see the source data, go ahead 
and create those charts directly in PowerPoint—you’ll get all the same capabilities as if 
you created the chart in Excel, with no drawbacks.

Note
If you want to paste your picture as an Enhanced Metafi le, you can use the Copy As Pic-

ture tool in Excel in place of step 3 in the preceding steps. Using Copy As Picture instead

of just copying your chart with CTRL+C ensures that you won’t risk pasting an unwanted

embedded or linked object. The downside to Copy As Picture is that PNG is not an avail-

able paste format in the destination 2007 release program when you use this method.

To use Copy As Picture, select the chart and then, on the Home tab, click to expand Paste 

options, point to As Picture, and then click Copy As Picture. In the Copy As Picture dialog

box, shown here, the Appearance option As Shown On Screen usually provides the better 

results. Use the Picture option for Picture (Enhanced Metafi le) to be an available Paste 

Special option in the destination program.
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